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ProAdmin version 2.02 February 2007 

ProAdmin version 2.02 introduces the ability to run batch estimates, rename fields, create custom J&S 

payment forms, and access a fulfillment tool. You’ll find details about these and other enhancements below. 

 
System 

 Batch Estimates are now available on the 

Execute menu.  This new calculation type allows 

you to run estimate calculations for a group of 

individuals that are referenced in an external text 

file or chosen using a Selection Expression.  The 

text file has the Person ID, Decrement Date, and 

Commencement Date.  If you need multiple 

Decrement or Commencement dates for an 

individual, enter them as separate rows in the 

file.  The Selection Expression is a logical 

expression for selecting the records from the 

data source. 

See Batch Calculation on page 14. 

 ProAdmin now has an alternative “Calculator 

Only” Interface.  This interface could be used by 

junior staff to run calculations while protecting 

the source plan setup parameters. 

See New “Calculator Only” Interface on page  

11. 

 Data Dictionary fields, benefit formula 

components, accrual basis components, and 

custom operators can now be renamed.  All 

references to the item are changed automatically. 

 The data dictionary, benefit formula component 

and accrual basis component libraries now show 

the type of item along with the name and 

description. 

 

 ProAdmin can now be used on a secondary 

monitor.   

 After saving output to a file, you can now press 

the “Open File” button to open it rather than 

browsing to find it. 

 

 You can now select multiple items in checkbox 

lists by (a) clicking the first item and then (b) 

holding down the shift key while clicking the 

last item. 

 

 Import from Client now behaves more like the 

old Client to Client Copy for Data Dictionary 

items.  Now, fields with the same name, type 

and codes/labels are considered a match.  
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 Checks, checkboxes, and line drawing characters 

now display correctly on Korean computers. 

 There is a new “auto complete” feature for edit 

controls that allow a user to enter a path to a 

client folder.  As the user types in the edit 

control, a list containing directories with a 

matching pattern appears and changes 

dynamically as each letter is typed.  

 In expressions, a horizontal scroll bar will now 

appear when the formula is wider than what is 

visible.  

 

 ProAdmin will now prompt you to pack files 

upon exit if wasted file space is greater than 

certain limits.  Limits are optionally specified in 

the [Config]section of the PROVALW.INI file 

using these settings: PackLow =  (default is   

100 MB) - savings must be at least this setting 

and  pass the PackPercent test, PackHigh =    

(default is 200 MB) - always pack if  savings 

will be greater than setting, and PackPercent = 

(default is  0.20) - savings must be at least this 

setting and pass the PackLow test 

 The ProAdmin License Server (PVLS) can now 

be installed as a Windows Service on Windows 

NT/2000/XP machines. 

For more information, see “License Server 

Installation Guide.pdf” in the ProAdmin folder. 

 ProAdmin now remembers the size of dialog 

boxes that you resize. Sizes will be maintained 

for all similar dialogs and will be retained for 

future sessions. 

 ProAdmin will now retain sort criteria for 

libraries (i.e., by name or by date last modified). 

All libraries will be sorted according to the last 

used criteria. For example, if you sort benefit 

formula components by name, then when you 

open the census specifications library, it will 

also be sorted by name. If the sort criteria does 

not exist for a specific library, the library will be 

sorted by the name column.  

 ProAdmin will now remember the last entry that 

was selected in each library. 

 A new List Objects command (on the File menu) 

lets you list the entire inventory of objects in the 

current client.  Objects that are not referenced by 

another object are asterisked in the list. 

 

Data Dictionary 

 It is now possible to delete unneeded values 

from coded fields.  The code can be deleted if it 

does not exist on any databases and the field is 

not referenced in a data default. 

Census Specifications 

 If your data contains missing values, there is 

now a simple way to use data defaults to zero 

out missing values in all numeric fields  (except 

for salaries). 
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Interest Rates 

 ProAdmin now supports duration-dependent 

interest rates such as those used to determine 

commuted values for Canadian plans.   

See Duration-Dependent Interest Rates, 

page 13. 

Final Average Salaries (FAS) 

 The salaries that make up the high final average 

salary are now identified in the detail output of a 

calculation.  For monthly FAS calculations, they 

are presented in the detailed monthly report for a 

specified decrement age.  For an annual FAS, 

they are included in the regular FAS table.  The 

new column is blank if the salary is not in the 

highest average; otherwise the salaries used are 

indicated as 1 through n. 

 The salaries that make up the high final average 

salary are now available for export through 

stand-alone type (not XML) output definitions. 

 

The output is an array that includes an identifier 

(e.g., 5∆FAS∆10), the salary date, the salary and 

the limited salary. 

Users can output the high FAS information from 

a Benefit Definition (with output by decrement 

date), a Benefit Formula Component or an 

Accrual Basis Component.  If more than one 

final average salary operator is referenced, the 

outputs for all are included.  The run will abort if 

no final average salary operators are referenced. 

 For final calculations only (i.e., not for estimates 

of any kind), you can now allow the FAS at 

decrement to be set equal to the greater of the 

otherwise calculated FAS at decrement and the 

FAS at all later dates. For example, if unused 

vacation time is spread out over future pay 

periods, the FAS can be the highest value 

including these future periods. 

 

 The final average salary custom operator will 

now allow for a FAS to be calculated using only 

those salaries earned within the averaging period 

(e.g., 5 years) but have the denominator for the 

final average be equal to the weight of the 

salaries for the period.  This can only be done 

when service is used to count measurement 

period salaries.  In this situation the average may 

be based on a period where the weight of the 

salaries is less than the averaging period. 

 

PIA Custom Operators 

 The PIA custom operator now allows a freeze 

year to be specified by a date field. When used 

wage bases, salaries, CPI and national average 

wage (NAW) values will be frozen for the PIA 

calculation in the calendar year of the date in the 

specified date field. 

 

 

 The PIA custom operator has a new backwards 

salary projection option where salaries can be 

projected backward from decrement reflecting 

both the historical NAW values and an estimated 

NAW for the year prior to decrement.  Use of 
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this option requires a regulatory data text file 

named RegEstNatAvgWage.txt. 

 The PIA custom operator now allows you to 

ignore salaries at decrement even if decrement is 

12/31. With this option, the calendar year salary 

in the year before decrement is used as the 

decrement salary. 

Service Definitions 

 A new elapsed time calculation method has been 

added to, generally, emulate the Microsoft® 

Excel® DAYS260 calculation.  The new method 

is called “360 days per year (30 per month).” 

Salary Definitions 

 Bi-weekly and weekly measurement periods are 

now available for use in a salary definition. 

These also may be determined from salaries on a 

less frequent basis. 

Database Linkage 

 You can now optionally right your own SQL 

statement to retrieve data. 

Tables 

 An “age by month” table type is now available 

for Conversion Tables, Benefit Formula 

Component Tables and Accrual Basis Tables. 

 Mortality tables have been enhanced to add 

more projection options.  Specifically, mortality 

projection scales can be specified by name and 

tables can be projected to a fixed year.   

 

 Benefit Formula and Accrual Basis component 

tables can now be interpolated to exact age.   

 

Annuity Factor Components 

 You can now specify an alternative interest rate 

assumption and zero mortality during the 

deferral period for annuity factor components.   

 

 Annuity Factors now allow you to date-adjust 

the interpolation age/period for deferred and/or 

temporary annuity factors. 
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 For joint and survivor annuities, you can now 

reference an assumed beneficiary age (“age 

setback”) rather than using the actual spouse 

date of birth (if any) on the data.  Note that this 

approach will always produce a joint & survivor 

annuity whereas the default approach will return 

a life annuity if there is no spouse 

 

Payment Forms 

 A new payment form type - "Custom Contingent 

Joint Life Annuity" - is now available. This form 

will return a joint life annuity with the 

beneficiary fraction (e.g., 0.5 for 50%) specified 

in the referenced database field. There is no 

conversion for this option. ProAdmin will 

simply return the unadjusted member benefit 

and calculate and return the beneficiary benefit, 

the deferral date if appropriate, and the relative 

value if requested. No values will be returned for 

this payment form if the referenced database 

field is empty. 

 The payment form library has been re-organized 

from a tabbed approach to ProAdmin's more 

standard topic approach. Some items were also 

re-ordered to have the least-used items last.   

 

 Annuity factors can now be interpolated based 

on exact age. 

Plan Definitions 

 Multiple benefit definitions can now be omitted 

from (or added to) a plan definition at once. 

Canadian Pension Plans 

 Benefit Definitions can now automatically apply 

the Canadian Maximum pension limit. 

 There is a new operator, #CANMAX, to apply 

the maximum pension to benefit formulas. 

See ITA Maximum Benefit, page 6. 

Tools > Administration Factors 

 You can now specify zero mortality during the 

deferral period for annuity factor calculations.  

Tools > Fulfillment Tool 

 There is a new command on the tools menu to 

launch ProAdmin’s fulfillment tool.  This new 

feature allows you to create links between Word 

documents and fields in the Access database 

created when you save your Output Definitions 

to Access.  The fulfillment tool also allows you 

to set formatting options for the fields. 

See Fulfillment Tool, page 17. 

Changes Log 

 Be sure to read the changes log (see What’s New 

in Help or the ADMCHG.LOG file in the 

ProAdmin directory) about updates to certain 

calculations that may change results. 
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Canadian ITA Maximum Pension Limit 
 

ProAdmin now can automatically handle the Canadian Income Tax Act (ITA) maximum pension limit of a dollar 

amount ($1,722.22 before recent legislation) multiplied by years of service and adjusted for early retirement.  

Enhancements to ProAdmin include: 

 A new option in Benefit Definitions to limit benefits by either the  U.S. 415 limit, the ITA Maximum 

Pension, or no limit 

 A new operator, #CANMAX 

 Detailed results of the ITA maximum pension limit calculation 

Benefit Definitions 

Benefit Definitions now include the ability to limit by the ITA Maximum Pension.  

 

 

If a new Benefit Definition is created, the default is to apply the U.S. 415 limit to the benefit formula.   

#CANMAX 

In addition to applying the ITA Maximum pension to the entire benefit definition, a new operator, #CANMAX, is 

now available for use in benefit formulas and accrual basis formulas.  #CANMAX accepts one or two arguments.  

The right argument is the deferral age (where 0 equals immediate, or no deferral) and is required.  The left 

argument is service and is optional.  A 0 or missing left argument indicates all service, 1 is post-reform service 

only and 2 is pre-reform service only.   
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For example, in lieu of applying the ITA maximum pension to the benefit definition, you may want to compare 

the normal retirement benefit to the ITA maximum pension before reducing for early retirement.  This could be 

specified as: 

(NRB #MIN (#CANMAX 60)) * ERF 

Additionally, the pre- and post-reform service options of #CANMAX should be useful for Canadian Plans that 

value the return of employee contributions.  For example, this formula finds the excess, if any, of the pre-reform 

benefit over employee contributions with interest: 

[(PreNRB #min (2 #CANMAX 60))*LSFact ] #zminus EECWI 

Note that the right argument of 60 on #CANMAX causes the operator to return the maximum benefit unreduced 

for early retirement.   

Plan Definition 

The parameters for calculating the Canadian ITA Maximum Pension are specified under the Regulatory Data 

topic of Plan Definitions.  

 

Within the Regulatory Data topic, you may: 

 Override the historical regulatory data values, 

 View the historical regulatory data,  

 Specify pensionable service (where the default is <date of hire> from Census Specifications) for the ITA 

Maximum, 

 Specify pre- and post-reform service for the #CANMAX operator, if desired, and 

 Reflect public safety occupation early retirement reductions if desired. 
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Service 

Under the Regulatory Data > Canadian Maximum Benefits button, pensionable service for the ITA Maximum 

pension defaults to the <Base Service Set> as defined in the Census Specifications.  Alternatively, you may 

specify a different Service Definition Set.  Similarly, post-reform service may be specified as a Service Definition 

Set.  Since pre-reform service is frozen by definition, it can only be specified as a database field.  Note that as the 

maximum pension under the #CANMAX operator is calculated over time, ProAdmin will define pre-reform 

service as the lesser of pensionable service and the specified pre-reform service amount.  However, post-reform 

service is taken literally, although ProVal will provide a warning if it is greater than total pensionable service. 

Early Retirement Factors 

The ITA maximum pension early retirement reduction factors are 3% per year prior to the earliest of age 60, 30 

years of service, and 80 points (age plus service), but not more than 45%.  If you check the box to “Use public 

safety occupation early reduction factor”, ProVal will instead reduce the maximum pension 3% per year prior to 

the earliest of age 55, 25 years of service and 75 points.  The early retirement factors used always reflect total 

service even if the operator is based on just pre-reform or post-reform service. 

Dollar Limit 

The Regulatory Data > Historical Data… button allows you to view the default dollar amounts used to calculate 

the ITA maximum pension limit, where the current Canadian amounts are shown in the table on the right.  

Pension plans that have not been amended to take advantage of the increased ITA maximum pension may 

override these dollar amounts with the ‘old’ limits as shown in the dialog box below. 
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Projection Assumptions 

The Regulatory Data topic applies to historical data.  The Regulatory Data Increase Rates topic under Projection 

Assumptions is where increase rates after the valuation date on the ITA dollar maximum are specified.  These 

increase rates increase the dollar limit from the most recent historical data amount to each future calendar year.  

  

 

 

 

 

 

 

 

 

 

 

 

 

Year 

ITA maximum 

Pension YMPE 

1935 1,722.22 0 

1936 1,722.22 0 

1937 1,722.22 0 

... ... ... 

2003 1,722.22 39,900 

2004 1,833.33 40,500 

2005 2,000.00 41,100 

2006 2,111.11 42,100 

2007 2,222.22  

2008 2,333.33  

2009 2,444.44  
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Sample life output 

Sample life output has been created for the operator #CANMAX and the ITA Maximum Pension calculation. 
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New “Calculator Only” Interface 
 

ProAdmin has a new alternative interface which shields the user from all the input commands and consolidates all 

the calculation commands into one.  The new interface allows the user to run all three types of calculations: 

Estimates, Finals and Dates/Age/Service calculations.  This interface was designed to allow our ProAdmin users 

to give their junior staff the ability to run calculations and produce output without worrying about them disturbing 

the source plan setup.  The new interface also allows multiple users, from their own installations of ProAdmin, to 

access the same client files. 

To activate the Calculation Only interface, you need to add the following line to the [Config] section of your 

PROVALW.INI file:  CalcOnly=Y.  To switch the interface back to normal, either change the CalcOnly 

parameter to N or remove it entirely.  

 

One major difference between this calculation only command and the standard calculation commands is that the 

user must first set up a System Plan.  The System Plan is basically just a named collection of a Plan Definition, 
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Census Definition, Projection Assumptions and an Output Definition.  The user setting up the System Plan should 

give it a descriptive name sufficient for the Calculation Only user to select the proper plan.  When setting up the 

System Plan, you do not need to reference an XML Database Linkage and you do need to reference a standalone 

type of Output Definition. 

In addition to selecting a System Plan, the user needs to enter the Person ID to process.  There is a Database 

Lookup button to assist the user with selecting the Person ID.  This button will display a table and fields selected 

by the user within the database attached through the Database Linkage.  The user can select a row within the table 

and that Person ID will be pasted in the Person ID field. 

Once the user has run the calculation, it can be saved back to the ProAdmin library by calculation type.  For 

example, if the calculation type was set to “estimate”, the calculation will be saved back to the library within the 

Estimate command.  The naming convention of the new library entity is automatically generated by the 

Calculation Only command.  The format of the new name is Person ID * User ID * Sequence number.  The User 

ID is taken from the User setting in the PROVALW.INI file.  The Sequence number begins at one and is 

incremented by one for each run with the same Person ID and User ID combination. 

All the same output options as the standard calculation commands are available once the calculation has been run.  

There is also a “Saved Calc” lookup button to allow the user to recall a previously saved calculation.  The lookup 

button displays a consolidated list of calculations run from the Calculation Only command from the Estimate, 

Final and Dates/Ages/Service libraries. 
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Duration-Dependent Interest Rates 
 

ProAdmin now supports duration-dependent interest rates such as those used to determine commuted values for 

Canadian Registered pension plans.  Similarly to all interest rates in ProAdmin, the table of historical rates is 

maintained outside of the system and referenced, and optionally adjusted, through the Interest Rate Tables library. 

The file name for duration-dependent 

interest rates must contain “_dur” 

immediately before the file extension
1
.  

For example, 

Canadian_indexed_dur.csv and 

Canadian_indexed_dur.txt are both 

valid duration-dependent interest rates 

file names. 

Within the file of duration-dependent 

interest rates, each row must contain at 

least three values and must have an odd 

number of values.  Each row may have 

a different number of values.  The first 

value is the year.  It must be an integer 

between 1900 and 2200, inclusive.  The 

second value is the month.  It must be 

an integer between 1 and 12, inclusive.  

The third, 5
th
, 7

th
, etc. values are the 

interest rates.  The 4
th
, 6

th
, 8

th
, etc. 

values are durations for the interest rate 

in the previous column.  They must be 

positive integers between 1 and 99, inclusive.   

A partial example of a valid duration-based interest rate table with tab delimiters is as follows: 

1997 8 0.04 10 0.05 8 0.04 

1997 9 0.04 10 0.0475 9 0.04 10 0.0475 

1997 10 0.0425 20 0.05 

1997 11 0.04 10 0.0475 

1997 12 0.04 10 0.0475 

1998 1 0.0425 10 0.0475 

1998 2 0.0425 10 0.0475 

1998 3 0.0425 10 0.0475 3 0.0425 10 0.0475 

1998 4 0.0425 10 0.0475 4 0.0425 10 0.0475 

Note that when the sample life tables for payment forms shows an interest rate, for duration-based interest rates, 

only the first rate is shown. 

                                            
1
 The preferred method for specifying U.S. PBGC-style interest rate tables is “_pbgc” just before the file extension, but pbgc 

anywhere in the name still works. 
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Batch Estimates 
 

ProAdmin now allows for the execution of Batch Estimates.  This new option is accessed from the Execute menu. 

 

 

 

 

This new feature references an external text file that is used to identify the individuals that should be processed as 

part of the batch run.  The text file is a comma separated file with one row for each calculation request, where 

each row contains the Person ID, Decrement Date (MM/DD/YYYY format), and Commencement Date 

(MM/DD/YYYY  format).  The Person ID is the value that identifies the record in the database.  There is only one 

(1) Commencement Date allowed for each Decrement Date.  If you need multiple Commencement Dates for a 

particular Decrement Date that combination will need to be a separate row. 
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The following is a sample of the contents of a file that will process calculations for three (3) individuals. 

123-45-6789,06/30/1996,02/01/2006 

123-46-5789,04/30/2006,05/01/2006 

123-47-5689,03/31/1997,10/01/2006 

The Selection Expression feature allows you to write a logical expression for selecting records from the data 

source using ProAdmin’s expression language. 

 

 

The Selection Expression is a logical expression for selecting records from the data source.  While you are 

entering the expression, you can press the F1 key to see a summary of the available operators and field names.  

Decrement Date can be either a constant or a variable.  Enter a constant date in the format MM/DD/CCYY.  If 

you want to use the variable date, select the Eligibility Definition and Service Definition Set for ProAdmin to 

evaluate.  ProAdmin will first process a Dates/Age/Service calculation to determine the decrement date. 

Commencement Date/Age can be a constant date, constant age, or a variable commencement date.    Enter a 

constant date in the format MM/DD/CCYY.  Enter the constant age as an integer.  If you want to use the variable 

date, select the Eligibility Definition and Service Definition Set for ProAdmin to evaluate.  ProAdmin will first 

process a Dates/Age/Service calculation to determine the commencement date. 

 

All calculation results, including processing messages, will be sent out to the Output File that you identify.  The 

batch estimate will only write results to an Access Database. 
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When you run a Batch Calculation, ProAdmin will extract the data from the database identified under the 

Database Linkage assumptions and process the calculation.  As calculations are processed it will give you a 

running count of the number of calculations to be processed and which calculation it is executing. 

 

 

When the calculation run completes, you will see a summary dialog.  This will give you information on the 

number of records in the file, records processed (those records that were matched in the database), estimates 

completed, and aborts. 

 

 

The View button will display the Batch Estimate Listing.  This report will give you information about the Census 

Data, Census Specifications, Plan Definitions, Projection Assumptions, Output Definitions, Output File, and 

processing messages for the calculation run. 
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Fulfillment Tool 
 

ProAdmin now has a Fulfillment Tool that will allow you to merge the Output Definition Results when saved to 

Microsoft Access with a Microsoft Word document.   

 

When you select the Fulfillment Tool selection on the Tools menu it will launch the ProAdmin Fulfillment Tool.  

The first step is to open the Access database that you created when you saved the calculation results.  Do this by 

clicking the  icon. 

 

After you open the Access database, the Fulfillment Tool will display a list of all calculations stored in the 

database.  The list will display Name, Run Type, Person ID, Run Date, Package, and Generated.  You can sort the 

list by clicking on any one of the headings.  The first time you click on the heading it will sort in ascending order.  

The second time you click it will sort in descending order.   

Name is the descriptive name that you gave the entry in the Estimate, Final, or Batch Estimate Library.  Run Type 

is the type of calculation either Estimate or Final.  The Person ID is the Person ID field from the calculation 

request.  The Run Date is the date that the calculation was run.  Package is the fulfillment that should be generated 

for this calculation.  Generate is the date that fulfillment package was either Previewed or Generated. 

The Preview icon  will open up Microsoft Word and create the merged documents based on the 

information that you entered in the Package Map and Field Mappings  topics. 

The Generate icon  will create and save the merged documents to a specified directory. 
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Click the Package Map icon  to link all of the documents that should be created for a particular Package 

Code and to specify the output folder.  The Package Code drop down will display a list of all Package Codes 

contained in the Access database.  The Document File is where you set the path and file name.  Enter a separate 

line for each document that is required for a particular Package Code. 

The Output Documents folder is where the Fulfillment Tool should save all packages created through the 

Generate selection. 

 

 

Click the Field Mappings icon  to set the Document Label, Access Table, Access Column, field Format, 

Default values, and Payment Form information. The Document Label is the Word Merge field name in the 

appropriate document.  If the same field is used in multiple documents you only need to create it once.  The Table 

is the Microsoft Access table that contains the output from ProAdmin that should be merged into the field.  The 

Column setting is the column within the table that contains the merge data.  Format is the formatting style for the 

data.  The Fulfillment Tool will apply the formatting style prior to merging the data.  Default is a default value if 

the data is not present in the Access database.  Other Details will show the corresponding Payment Form that 

will be used to filter the results. 

 

 


